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I. Introduction to MacCheck

MacCheck is an Apple support utility tool with which you can learn more about your
Macintosh computer, as well as diagnose software problems that result from 
corrupted directories and files. By using MacCheck in conjunction with Disk First 
Aid, you can resolve common disk corruption problems. 

MacCheck creates a profile of your Macintosh computer, including:
• The processor, memory, expansion cards, SCSI drives, keyboard, monitor, etc.
• The installed applications and system software on your startup drive

MacCheck also provides:
• A general logic board test
• A checker for the file system and System files
• A checker for duplicate System Folders

The MacCheck product consists of the application file “MacCheck™”, and the data 
file “MacCheck™ dataFile”. For MacCheck to work correctly, both the application 
file and the data file must be located in the same folder. MacCheck is compatible 
with System 7.0 (or later).

Under most circumstances, MacCheck can be run with extensions on.  However, if 
you are having trouble running MacCheck, you should turn extensions off (by 
restarting your computer while holding down the Shift key).  MacCheck does 
conflict with some non-Apple extensions:
  • Thunder 7:

Do not  run MacCheck while Thunder 7 is active.  MacCheck and Thunder 7 
have serious conflicts.

  • Virus protection programs:
You will need to "teach" some virus protection programs about MacCheck.

• Electronic mail programs:
Sometimes when electronic mail programs, such as Microsoft Mail or 
QuickMail, are active, they disrupt the file system checking (by making your 
startup volume "busy"). 
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II. MacCheck Overview

Launching MacCheck
When you launch MacCheck, you will see a splash screen detailing the 
initialization processes that MacCheck performs while it starts up. During most 
of this time, MacCheck gathers profile information and checks for multiple 
System Folders. On a new Macintosh LC III, MacCheck takes about 1 minute to 
launch; on a 400 MB, 8,000-plus-file Macintosh Quadra 950, it takes about 4–5 
minutes to launch. 

Note: If you want to speed up the launch process by about 20 seconds, press 
the Space bar when the splash screen first appears. This tells MacCheck not to 
profile modems or check SCSI devices that are typically slow, such as DAT tape 
drives. MacCheck will display a “•QuickBoot•” message.

Note: If you want to quit the launch process at any time, press ⌘-.period.

Accessing Profile Information
MacCheck stores the collected profile information in three log files, the “System 
Info”, “Additional System Info”, and "Application and Font Info" logs. To view the 
profile information placed into these logs, select the log you want from the 
Windows menu.

Starting Logic Board and File System Tests
To start the logic board and the file system tests, click the Test button or select 
the Test option (⌘-G) in the Diagnostics menu.  When these tests are 
completed, MacCheck stores the results in a results file.  The default name of 
this file is "Test Results-1".  You may rename this file by selecting the Save 
Results As option in the File menu. 

Getting Help
Consult the Help menu or click the Help button if you have questions about the 
information in the "System Info", "Additional System Info", or "Application and 
Font Info" logs. Help also provides suggestions of what to do if MacCheck 
detects a problem and includes troubleshooting tips.

MacCheck has added information about its menu items and buttons in Balloon 
Help (see your user's guide for information on using Balloon Help).
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III. How to Use MacCheck Menus

   

Fig 3.1  MacCheck File Menu

File
The MacCheck logs are considered to be documents, so the File menu items 
behave in similar ways as the File items in other applications, such as 
TeachText.  As with TeachText, there can be only one open document at a time.
MacCheck does, however, do a few things differently:

• New Results
Clears all the logic board and file system test information stored in the 
results file; does not clear the profile information after the bullets ("•••…") 
that MacCheck gathered while launching.

• Open Results
• Save Results

Saves the results log, "System Info" log, "Additional System Info" log, and 
"Application and Font Info" log into one results file, labeled with the name of 
the results log (default: "Test Results-1").  When you open a results file, 
MacCheck reads back in the four logs that were previously saved into that 
results file.

• Close
Hides the front-most log or closes the "Help-Topics" window, if it was the 
front-most window.  To make a log the front-most window, use the Windows 
menu and select the log you wish to view.
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• Print Results 
Prints the front-most log. You also can choose to print any of the other three 
logs from the same print dialog.

Fig 3.2  Diagnostics Menu

Diagnostics

• Test…
Starts the logic board, file system, and System file checking tests.  
MacCheck performs the check for multiple System Folders only when first 
launched.  Once MacCheck starts these tests, the "Test…" item becomes 
grayed, and the "Stop Testing" item becomes enabled.

Fig 3.3  Windows Menu

Windows
When you select an item in the Windows menu, MacCheck will bring that log 
forward, making it the front-most window.  If you have viewed Help, but not 
yet closed the "Help-Topics" window, you can also select the "Help-Topics" 
item in the Windows menu.  If no Help window is open, the "Help-Topics" item
will not appear in the Windows menu.  MacCheck places a check mark next 
to the window that is currently front-most.
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IV. How to Use MacCheck Help

Fig 4.1   Help Menu and Help Window

When you click the Help button in the main MacCheck window, or select "Topics" 
from the Help menu, MacCheck displays a window containing eight Help topics; 
each topic contains one or more pages of information. 

To go to the next or previous page of help for a particular topic, press the inner 
arrow keys at the top of the Help window.  To go to the next or previous Help topic, 
press the outer arrow keys at the top of the Help window.  You can also select the 
topic you want to view by using the pop-up menu at the top left of the Help 
window.

The last three Help topics, “Sad Mac Codes [Newer Machines]", “System Errors 
[Positive Codes]”, and "System Errors [Negative Codes]", are intended as a 
technical reference. 

Note: When you run MacCheck on a Macintosh Plus, SE, Classic, or Classic II, the 
"Help-Topics" window becomes a "modal" window (i.e., the title and title bar are not
visible and you cannot move the window), to save screen space.
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V. Common Errors Reported by MacCheck
and Suggestions to Resolve Them

Multiple System Folders
MacCheck detects multiple System Folders and displays them in the "Additional 
System Info" log.  Although you can safely store multiple System Folders on 
your drive, many problems can be traced to additional System Folders 
inadvertently placed on drives. Ignore the warning if you intend to have 
multiple System Folders; otherwise, Apple recommends removing the extra 
ones.

Directory Corruption Detected
If MacCheck detects directory corruption during its file system test, locate the 
Disk First Aid program on your Utilities  or Disk Tools  disk.  Then follow the 
procedure detailed below:

1) Shut down your Macintosh (via the Special menu).
2) Insert your Utilities  or Disk Tools  disk and turn on your Macintosh.
3) When the Finder appears, run the Disk First Aid program.
Note:  Be careful to designate the drive that MacCheck detected the problem 
on as the drive that needs to be fixed.
4) Choose Quit to return to the Finder and choose Restart from the Special 
menu to restart your Macintosh.

Occasionally, Disk First Aid versions earlier than version 7.2 will not find or fix 
the problems that MacCheck has detected.  If you run MacCheck after running 
Disk First Aid, MacCheck may still detect file system problems. If this occurs or 
if MacCheck tells you that it detected problems that Disk First Aid cannot fix, 
the problems can be corrected by reinitializing your hard drive using Apple HD 
SC Setup.  Please make sure that you have backed up your drive (using Apple 
Backup if you are a Performa user) before reinitializing your drive.  Some non-
Apple utilities may be able to repair problems that Disk First Aid cannot (and 
vice versa), though reinitializing your drive is the only way to be sure that the 
problems that MacCheck detected are fixed.

System File Corruption Detected
If MacCheck detects corruption problems in your System, Finder, System 
Enabler, or Launcher (Performa) files, replace these files from your original 
Apple installation disks. If you are a Performa user, restore a backup of your 
System files with Apple Restore program.
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Logic Board Failure
If MacCheck detects a logic board failure, shut down your Macintosh by 
selecting Shut Down from the Special menu. Restart your Macintosh while you 
hold down the Shift bar to ensure that all extensions are off, and run MacCheck 
again. If MacCheck still detects a logic board error, contact the Apple Assistance
Center or your Authorized Apple Service Provider.

VI. Common Warnings Reported by MacCheck

Bad File Creation Dates
The "Additional Systems Info" log lists all files with bad creation file dates (a 
creation date later than the last modification date). This usually means that 
some time in the past the system clock was not set up correctly. This warning is 
not fatal, and since it is time consuming to reset file dates, you may not wish to 
repair these files.  Apple’s ResEdit and some non-Apple programs will help to 
reset file dates.

MacCheck Gives a “Log full” Warning
If you have too many files with bad creation dates, or too many aliases that are 
unresolved (i.e., if you double-click on the alias, the Finder gives you a 
"Document/file cannot be found" error), MacCheck may not be able to fit all of 
the regular profile information into the “Additional System Info” log.  You might 
also fill the "Application and Font Info" log if you have too many fonts or 
applications.

File System Test Can’t Test This Kind of Volume
MacCheck only tests for file system and System file corruption on volumes that 
are not locked (i.e., it only tests volumes that you can repair). MacCheck 
considers CD-ROM drives and file-server drives locked.

File System Test Reports Volume Is Busy
MacCheck should be the only program running while it performs the file system 
test.  The results are not valid if other applications, extensions (including File 
Sharing), or Control Panel device programs are running at the same time as 
MacCheck.
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VII. MacCheck Operating Tips

A “Software Bundle ID = xxx-xxxx” message may appear at the bottom of the 
launch splash screen.  The Software Bundle ID is a unique number that identifies 
what system software (7.0, 7.1, US, France, etc.), applications, or additional 
software was installed on the drive at the factory.  MacCheck displays this 
information if the bundle information is detected during launch.

If MacCheck is running on a Macintosh Performa, it reports only that it is running on
a Performa; it does not report the Performa model name.

On larger drives, the “Gathering Miscellaneous Boot Volume Statistics” section of 
the launch process often takes the most time, as MacCheck searches for bad file 
creation dates.

While tests are running, the File and Help menus and Help, Test, and Quit buttons 
are dimmed (not available).

If no printer is selected or if no log is currently selected, the "Print" and "Page 
Setup" menu items are dimmed (not available).

When the file system test is in progress, the status bar is updated only after each 
volume has been checked. For large volumes, this may mean that the status bar is 
“frozen” for a minute or two.

Note:  Apple Customer Service Division welcomes comments and suggestions 
from users of MacCheck.  You may send messages to one of the following 
addresses:

Internet: maccheck@guest.Apple.com 
AppleLink:  MacCheck
US Mail: Apple Computer, Inc.

20525 Mariani Avenue, M/S 72-W
Cupertino, CA 95014-9968
ATTN: MacCheck Manager
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VIII. Software Profiling Technical Details

This section contains details about the information gathered by the software 
profiling function of MacCheck. Most of the information pertains to the currently 
active System file on the startup disk. If no information is available for a particular 
category, then “None” or "Unknown" is reported for that category.   For more 
details on the terms used in this section, refer to your Macintosh user's guide, the 
Apple Inside Macintosh series of programming books, or other Apple development 
documents.

Note: Every file's version number is stored in a 'vers' (id=1) resource as both an 
encoded number and as a string.  The Finder displays this string when you do a 
"Get Info" (⌘-I) on a file.  When MacCheck displays a file's version number, it 
decodes the 'vers' resource's encoded number.  Sometimes software producers 
neglect to make the encoded number and the version string consistent.  If this 
happens, the version numbers that MacCheck and the Finder report will be 
different.

Note: When MacCheck reports a file that is an alias to some other object, the 
profiler attempts to resolve the alias.  The profiler reports information about 
where the alias points (if available). If an alias points to an object on an 
unmounted file server, the profiler reports it.

System
MacCheck reports:

• The version of the currently active system software
• The version of the System 7 TuneUp (if installed)

Finder
MacCheck reports:

• The version of the Finder used by the currently active system software
• The version number of the At Ease “mini-Finder”, if installed

AppleTalk
MacCheck reports:

• The state of AppleTalk (active/inactive)
• The version of the AppleTalk driver (if it can be determined)
• Phase 1 or 2 (as appropriate)
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System Enablers Installed
MacCheck reports the names and versions of any System Enablers found. 

Note: Starting with System 7.1, System Enablers are installed into the System 
Folder to provide functionality for new hardware and system software. 
(MacCheck does not indicate whether a particular System Enabler is valid on the
Macintosh being profiled.)

Communications Toolbox
MacCheck reports:

• The name and version of the Communications Toolbox (CTB), if installed
• Whether the Communications Resource Manager (CRM) is installed,
• The version of CTB tools found in the Extensions folder in the System Folder 

(i.e., Connection Manager, Terminal Manager, or File Transfer Manager, if 
installed)

QuickDraw Graphics
MacCheck reports the version of QuickDraw graphics being used.

Note: MacCheck can display these versions of QuickDraw graphics:
• Original QuickDraw (Mac Plus, Mac SE)
• Color QuickDraw (Mac II)
• 32-bit QuickDraw in ROM (Mac IIci)
• 32-bit QuickDraw file (System 6.0.4 or later)
• 32-bit QuickDraw in System (System 7.0 or later.  For 32-bit QuickDraw, the 

version number is also reported.)

Debugger
MacCheck reports the name (currently coded as MacsBug only) and version of 
the installed debugger.

Memory Addressing
MacCheck reports the memory addressing mode (24-bit, 32-bit, or not capable 
of 32-bit mode) of your Macintosh.

Virtual Memory
MacCheck reports:

• Whether Virtual Memory (VM) is being used or not (active/inactive)
• The location (when VM is being used) of the VM Backing Store file
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Disk Cache
MacCheck reports:

• The current setting of the disk cache
• Whether the disk cache is turned on or not (active/inactive)

Note: System 7.1 has a minimum 32K disk cache.

User Name
The user name is set using the Sharing Setup control panel and is stored in the 
System file. 

MacCheck reports:
• The user name, if it has been set
• "Unknown", if the user name has never been set 

Machine Name
The machine name is set using the Sharing Setup control panel and is used for 
File Sharing purposes. It is stored in the System file. 

MacCheck reports:
• The machine name, if it has been set
• “Unknown”, if the machine name has never been set

Chosen Printer
The type of printer chosen most recently (using the Chooser) is stored in the 
System file.  

MacCheck reports:
• “No printer has been chosen”, if no printer has ever been chosen
  O R
• The type of printer, if a printer has ever been chosen
• The name and version of the printer driver, if the appropriate printer driver is

found in the Extensions folder
• "Printer driver not found", if the appropriate printer driver is missing 
• The printer's network name and its location on the network, if the printer is a

shared network printer

Note:  If the printer is located in the user’s default AppleTalk zone and 
AppleTalk is currently off, MacCheck reports the printer's location as “Unknown”.
MacCheck does not report the connection port (serial or modem port) of direct-
connect printers, such as the ImageWriter.
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Default AppleTalk Zone
MacCheck reports:

• The user’s default AppleTalk zone, if it can be determined from PRAM or by 
querying a router

• “Unknown” if the user's default AppleTalk zone cannot be determined

File Sharing
MacCheck reports the state of file sharing (active/inactive).

Startup Device
You set the startup device from the Startup Disk control panel.  This information 
is stored in PRAM, for use the next time you restart your Macintosh. (This 
startup device feature is not available on the Macintosh 128K/512K/Plus.).

MacCheck reports:
• The startup device information stored in PRAM
• "None selected", if the startup device cannot be determined
• The SCSI ID, if the startup device is a SCSI device
• The slot number, if the startup device is a NuBus slot device
• "Internal Floppy Drive" or "External Floppy Drive" if the startup device is a 

floppy drive
• The volume name of the volume located on the startup device
• "Unknown", if the volume name is not available (e.g., when the original 

startup device specified is no longer available)

Note:  There is a complex set of rules for startup, which vary with the type of 
machine, volumes available at startup, boot blocks, etc. Sometimes the device 
that your Macintosh actually boots from is not the one selected in the Control 
Panel. 
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Volumes Online
MacCheck searches for all volumes that are currently mounted and identifies 
characteristics about each volume. It does this search only once during launch, 
so if a new volume is mounted during the execution of MacCheck, the change in
status won’t be reflected in the "Additional System Info" log.

For each volume found online, MacCheck reports:
• The name of the volume as known by the operating system
• The type, format, and attributes of the volume:

- Type is one of the following:
Floppy disk
Hard Disk 20 (HD20)
SCSI hard disk
SCSI  CD-ROM drive
RAM disk
AppleShare volume
Foreign File System volume
Unknown

- Format is one of the following:
Macintosh Filing System (MFS)
Hierarchical Filing System (HFS)
High Sierra CD-ROM
ISO 9960 CD-ROM
Audio CD-ROM
AppleShare volume
Foreign File System volume
Unknown

- Attributes are any of the following:
Read-Only
Ejectable
Non-Ejectable

• Where: The location of the volume, usually obtained from the volume’s 
device driver. If the device is a SCSI device, its SCSI ID is reported. If the 
device is a slot device, its slot number is reported. Special case messages 
are reported for floppy disks and HD20s.

• Total Capacity: The logical size of the volume, reported in the appropriate 
units--bytes, KB, MB, or GB--as well as actual bytes.
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• Free Space: The amount of logical free storage available on the volume, 
reported in the appropriate units–bytes, KB, MB, or GB--as well as the 
percentage full.

• Number of Files: The total number of files known by the operating system 
on the volume. In some cases this information is not available (such as on 
AppleShare file servers) and “Unknown” is reported.

• Number of Folders: The total number of folders known by the operating 
system on the volume. In some cases this information is not available 
(such as on AppleShare file servers) and “Unknown” is reported. If the 
volume is an MFS volume, any folders that might be visible in the Finder do
not actually exist and are not counted in the total.

• Last Backed Up: The date that the volume was last backed up by a utility 
that resets this information in the System File. If the volume has never 
been backed up, a date is not reported. 

Note: Simply copying files/folders with Finder does not change the “Last 
Backed Up” date, and many early third-party backup utilities do not change it
either. 

In addition to the above, MacCheck reports:

• Whether the volume is bootable
• Whether the volume is available for File Sharing
• Whether the volume has or should have boot blocks, plus additional boot 

blocks information:
- If the volume is not the startup device and has boot blocks.
- If the volume is the startup device and does not have boot blocks
- If the volume has boot blocks and they are invalid or the boot blocks 

version is too old
- The version of the boot blocks being used
- The name of the system file to use
- The name of the Finder (shell application) file to use
- The name of the debugger file to use (if any)
- The name of the disassembler file to use (old)
- The name of the startup screen to use (if any)
- The name of the startup application to use
- The name of the clipboard scrap file to use
- The maximum number of events the operating system can have in its

event queue
- The default size of the System heap (used by the operating 
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system when appropriate), reported in the appropriate units --bytes, 
KB, MB, or GB– as well as in actual bytes.

System Heap
MacCheck reports the current size of the System heap in the appropriate units – 
bytes, KB, MB, or GB--as well as actual bytes. 

Note: The System heap is used primarily by the operating system and System 
Extensions.  If running under a multi-tasking environment (i.e., System 7.x or 
greater), the System heap grows or shrinks as necessary. 

Apple Menu Items
MacCheck searches the Apple Menu Items folder in the System Folder and 
reports the name and version (if available) of any files it finds. 

Note: Some Apple menu items (called Desk Accessories) that were upgraded to
work under System 7 do not use the current version numbering conventions 
(i.e., having a 'vers' resource).  If MacCheck detects such a case, it may not 
always be able to figure out the version number of the file.

System Files
MacCheck searches the blessed System Folder for System Extensions, Control 
Panel programs, startup items, Chooser extensions, and fonts.  It reports the 
name, version (if available), if the file has been disabled, and any information 
particular to that type of file.

In System 6 and earlier systems, extensions (called INITs), control panels (called
CDEVs), and fonts are commonly disabled by changing the file's type.  Under 
System 7, the "Extensions Manager", an Apple-sponsored System Extensions 
utility written by Ricardo Batista, "disables" extensions by moving them to a 
new folder (appended with "(disabled)") in the System Folder.  Thus, the utility 
would disable a file in the Control Panels folder by moving that file into a folder 
called "Control Panels (disabled)".  The utility places inside the folder "System 
Extensions (disabled)" disabled extensions.  
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The pre-System 7 disabling method is still valid under System 7, so it is possible
to have disabled files in both the "Control Panels" and "Control Panels 
(disabled)" folders.  MacCheck does not report the files found in the "(disabled)"
folders as being disabled, as this would be redundant.  MacCheck also does not 
report files in the "(disabled)" folders that do not belong to that type--e.g., if the
user places a Chooser extension file into the "Control Panels (disabled)" folder, 
MacCheck will not report the file.

Note:  MacCheck has been tested extensively with version 1.6-2.0 of the 
Extensions Manager under System 7.x. No guarantee is made for earlier or 
newer versions. MacCheck does not support (report) any other schemes that 
non-Apple utilities may use to disable extensions.

System Extensions
MacCheck reports, for each System Extension, the extension's name, version (if 
available), the System heap requirements (in some cases this is an estimate), 
and if the extension is disabled.

MacCheck reports any extensions in the "System Extensions (disabled)", 
"Extensions (disabled)", and "Control Panels (disabled)" folders.  As noted 
above, MacCheck does not report these extensions as being disabled. 
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Control Panels
MacCheck reports the name and version (if available) of any Control Panel files 
found.  MacCheck reports if the file contains extension code, and if so, the 
System heap memory requirements of the extension code  (in some cases this 
is an estimate).  MacCheck does not report any non-control panel files that may 
be in the "Control Panels" folder. 

Chooser Extensions
MacCheck searches the Extensions folder in the System Folder for files that 
have the appropriate file type for Chooser Extensions, and reports the name 
and version (if available) of any file found.

Startup Items
MacCheck searches the Startup Items folder in the System Folder and reports 
the name and version (if available) of any file found.  Startup items are 
generally applications.

Fonts Installed
MacCheck reports the following information about installed fonts-- whether they
are located in the System file, in a suitcase file used by a third-party utility, or 
in the "Fonts" folder:

• Name: Family name of the font, which may also be the name you see in an 
application’s Font menu, depending on how the names are displayed in a 
particular application

• Font Family ID: Resource ID of the font family (the FOND resource or, on 
older systems, the FONT resource)

• Type: Either bitmap or TrueType. Font families with both types are listed 
separately

• Sizes Installed: For bitmap fonts, a list of all the available sizes (stored in 
resource files) and their associated styles; for TrueType fonts, the minimum
size supported 

• Where: Location path of font resources

Fonts (disabled)
MacCheck reports only the name of the font files that have been disabled by 
the Extensions Manager.
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Application Info
MacCheck finds all of the applications on the startup volume and reports the 
following information about each application: 
• Application name
• Minimum memory required (from the 'SIZE' resource)
• Preferred memory (from the 'SIZE' resource)
• Whether the application says it is 32-bit clean (from the 'SIZE' resource)
• Application's path

Miscellaneous Boot Volume Statistics
MacCheck reports miscellaneous information about files on the startup volume. 
Reporting this information involves searching the entire volume in one pass, 
which can take a long time, depending on the number of files and folders on the
volume.

MacCheck reports the following information :
• Duplicate System Folders: If the profiler finds a folder with both a System 

and a Finder file, it reports that folder as a duplicate System Folder.  The 
profiler writes the path of each folder found to the "Additional System Info"
log and writes a message to the main log telling the user whether or not 
duplicate System Folders were found.  Duplicate System Folders on CD-
ROMs are not considered to be problems; if the profiler detects them it 
writes their paths to the "Additional System Info" log and writes a message
to the main log telling the user that no duplicate System Folder problems 
were found.

• Creation Date/Last Modified Date In The Future: If files show a “future” 
creation or modification date, or the creation date is later than the 
modification date, the profiler writes the paths of these files to the 
"Additional System Info" log.  This problem generally indicates that the 
Macintosh clock was not set correctly or that there is a software problem 
related to saving the indicated files.

• Deepest Path: The profiler reports the depth of the deepest nesting of 
folders/files, along with the path to the deepest nested folder/file.
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• Longest Path: The profiler reports the length of the longest complete path 
name of a folder/file, along with the path to the folder/file that constitutes 
the longest path name.

Note:  Some applications cannot access a folder or file if the path name 
exceeds 255 characters.

IX. Hardware Profiling Technical Details

This section contains details about the information gathered by the hardware 
profiler section of MacCheck.   

MacCheck displays the following hardware attributes:
• Macintosh model (and machine ID--the "Gestalt" number)
• Processor (CPU) and clock speed (in MHz).   The clock speed is not 

displayed if it can't be accurately determined.
• Co-processor (FPU)
• Memory manager (MMU)
• Physical memory size in MB
• Logical memory size in MB
• Battery status (Portables and PowerBooks only)
• Hardware attributes
• Keyboard type
• ROM size in K
• ROM version
• ROM sub-version (Macintosh IIci and above)
• ROM checksum

On PowerBook Duo systems, MacCheck reports docking information for any 
dock that is connected. 

MacCheck displays the following information about each NuBus card 
installed:

• Slot number in hexadecimal
• Card name
• Board ID
• Board version

For machines with an LC-compatible PDS slot, the profiler reports the 
following information under NuBus slot $E:

• Card name
• Board ID
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MacCheck polls all active SCSI devices on the main Macintosh SCSI bus and 
reports the following information:

• SCSI ID (0 to 6)
• Device type (hard drive, CD-ROM drive, tape, printer, etc.)
• Device name (if a mounted block-device)
• Device size (if known)
• Vendor ID (if applicable)
• Product ID (if applicable)
• Revision (if applicable)
• Device serial number (if applicable)

Note: MacCheck does not handle the secondary SCSI bus on Macintosh 
Quadra computers, nor on third-party SCSI cards 

MacCheck checks for floppy drives installed and reports the following 
information:

• Drive ID (1 internal, 2 second or external, 3 if applicable)
• Drive type (800K, Apple SuperDrive, HD20, etc.)

MacCheck reports the following information for each installed external 
monitor:

• Screen size (pixels)
• Grays/colors (same as in the monitors CDEV)
• Horizontal resolution and vertical resolution, which are the same in 

most cases
• Location of monitor (built-in, attached to built-in video, or attached to a 

video card in a NuBus slot); the profiler also reports if the monitor is the
main screen

MacCheck checks for a Global Village modem attached to the modem port 
and reports one of the following in the "Additional System Info" log:

• Global Village modem is found
• Modem is found, but not recognized as a Global Village modem
• No modem is found
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X. Volume/Directory File Checker Technical Details

The Volume/Directory File Checker checks the directory structure and system files 
on HFS volumes.  It uses the following general algorithm:

For each mounted volume 
{
 if the file is a local HFS volume

Check the directory structure on the volume

 for each file in the blessed System Folder that is a System Enabler, Finder, or System file
Check the resource file structure

}

HFS Directory Structure Checking

The checker does a thorough analysis of each HFS volume and tests for the 
following:

• Volume checks
- Every block allocated to a file on a volume is marked in the volume 

bitmap
- Every block not allocated to a file on a volume is not marked in the 

volume bitmap
- Every file on the volume has a unique set of blocks.  No file claims 

blocks that are allocated to another file
• Directory checks

- Each directory has the same number of files and directories allocated 
to it that is claimed in the directory record

- The number of directories on the volume is the same as the number 
of directories found in the volume header

• BTree checks
- Each node in the catalog and extent trees has the proper valence
- Each node in the catalog and extent trees is properly marked in the 

volume bitmap
- Each node in the catalog and extent trees is referenced only once
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Resource File Checks

The Resource File Check does an analysis of the System files, and tests for the 
following:

• The resource fork is at least the minimum size. (There must be enough 
bytes to read a resource header)

• There is no overlap or space between the header, the resource data list, 
and the resource map

• There are no bytes between the End Of File (EOF) and the end of the 
resource map

• Each record in the resource data list is used once and only once. The last 
data item ends exactly where the data list ends.

• Each item in the resource type list contains at least one reference; each 
sequence of referenced items starts where the previous resource type 
item’s reference list ended; and each item in the reference list is pointed to
by one and only one resource type list item

• There are no duplicates in the resource type list
• Each name in the name list has one and only one reference, and the last 

name doesn’t point outside the name list
• Each reference list item points to a valid data item and either has a name 

list offset of –1 or points to a valid name list offset
• All names have a non-zero length
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